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1. Related Manuals 
 
To ensure system safety, always read and follow the information provided in all Safety 
Precautions and Precautions for Safe Use in the manuals for the devices that are used in the 
system. 
The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON) 
and Delta Tau Data Systems, Inc (DT). 
 

Manufacturer Manual No. Model Manual name 
OMRON I610-E1 Model CK3E- 

 
Programmable Multi-Axis Controller 
Hardware User’s Manual 

OMRON W580-E1 Model NY51-A 
 

Industrial PC Platform NY-series IPC 
Programmable Multi-Axis Controller 
Hardware User’s Manual  

OMRON W519-E1 Model NX-ECC203 NX-ECC201/ECC202/ECC203 
EtherCAT® Coupler Unit User’s 
Manual 

OMRON Z930-E1 Model NX-SL 
Model NX-SI 
Model NX-SO 

NX-SL/SI/SO 
Safety Control Unit User’s Manual 

OMRON W504-E1 Model 
SYSMAC-SE2  

Sysmac Studio Version 1 Operation 
Manual 

DT O014-E - Power PMAC User’s Manual 
DT O015-E - Power PMAC Software Reference 

Manual 
DT O016-E - Power PMAC IDE Users Manual 
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2. Terms and Definitions 
 

Term Explanation and Definition 
Slave Slaves are devices connected to EtherCAT. There are various types of 

slaves such as servo drivers handling position data and I/O terminals 
handling the bit signals. 

Object Represents information such as in-slave data and parameters. 
PDO 
communications 
(Communications 
using Process Data 
Objects) 

One type of EtherCAT communications in which process data objects 
(PDOs) are used to exchange information cyclically and in realtime.  
This is also called “process data communications”. 

PDO Mapping The association of objects used for PDO communications. 
PDO Entry PDO entries are the pointers to individual objects used for PDO 

mapping. 
ESI file 
(EtherCAT Slave 
Information file) 

An ESI file contains information unique to the EtherCAT slaves in XML 
format. 
You can load ESI files into the EC-Engineer, to easily allocate slave 
process data and make other settings. 

ENI file 
(EtherCAT Network 
Information file) 

An ENI file contains the network configuration information related to 
EtherCAT slaves. 
 

Power PMAC IDE This computer software is used to configure the Controller, create user 
programs, and monitor the programs. 
PMAC is an acronym for Programmable Multi-Axis Controller. 

Acontis 
EC-Engineer 

This computer software is used to configure the EtherCAT network and 
each slave. 
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3. Precautions 
 
(1) Understand the specifications of devices that are used in the system. Allow some margin 

for ratings and performance. Provide safety measures, such as for installing a safety 
circuit, in order to ensure safety and minimize the risk of abnormal occurrences. 

(2) To ensure system safety, always read and follow the information provided in all Safety 
Precautions and Precautions for Safe Use in the manuals for each device that is used in 
the system. 

(3) The user is encouraged to confirm the standards and regulations that the system must 
conform to. 

(4) It is prohibited to copy, reproduce, or distribute a part or the whole of this document 
without the permission of OMRON Corporation. 

(5) The information contained in this document is current as of July 2016.  
It is subject to change without prior notice for improvement purposes. 

 
The following notations are used in this document. 
 

 

Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury, or may result in serious 
injury or death. Additionally, there may be severe property 
damage. 

 

 
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury, or property damage. 

 

 Precautions for Correct Use 

Precautions on what to do and what not to do to ensure correct operation and performance. 

 

 Additional Information 
Additional information to read as required. 
This information is provided to increase understanding or make operations easier. 

 
Symbols 
 

 

The filled circle symbol indicates operations that you must carry out. 
The specific operation is shown in the circle and explained in text. 
This example indicates a “general precaution” for something that you must 
carry out. 
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4. Overview 
 
This document describes the procedures used to connect the Safety CPU Unit and Safety I/O 
Units (hereafter referred to as the Slave) attached to OMRON High EtherCAT Coupler Unit 
model NX-ECC203 using OMRON Programmable Multi-Axis Controller model 
CK3E-/NY51-A (hereafter referred to as the Controller) and EtherCAT, as well 
as for checking the connection. 
Refer to Section 6. EtherCAT Connection Procedure to learn about the setting methods and 
key points to perform PDO communications via EtherCAT. 
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5. Applicable Devices and Device Configuration 
 

5.1. Applicable Devices 
The applicable devices are as follows: 
 

Manufacturer Name Model 
OMRON Programmable Multi-Axis Controller Model CK3E- 

OMRON Programmable Multi-Axis Controller 
Industrial Box PC 

Model NY51-A 

OMRON EtherCAT Coupler Unit Model NX-ECC203 
OMRON Safety CPU Unit Model NX-SL300 
OMRON Safety I/O Units Model NX-SID800 

Model NX-SOD400 
 

 Precautions for Correct Use 

Use model NX-ECC203 Version 1.4 or later for the EtherCAT Coupler Unit. 
Models NX-ECC201 and NX-ECC202 cannot be used. 
Model NX-ECC203 Version 1.3 cannot be used. 

 

 Precautions for Correct Use 

In this document, the devices with models and versions listed in Section 5.2 are used as 
examples of applicable devices to describe the procedures to connect the devices and check 
their connections. 
You cannot use devices with versions lower than the versions listed in Section 5.2. 
To use the devices mentioned above with models not listed in Section 5.2 or versions higher 
than those listed in Section 5.2, check the differences in the specifications by referring to the 
manuals before operating the devices. 

 

 
Additional Information 
This document describes the procedures to establish the network connections. It does not 
provide information on operations, installations, wiring methods, device functionalities, or 
device operations, which are not related to the connection procedures. For more information, 
refer to the manuals or contact your OMRON representative. 
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5.2. Device Configuration 
The hardware components to reproduce the connection procedures in this document are as 
follows: 

 
 

 
 
 
 
 
 
 
 

Manufacturer Name Model Version 

OMRON Programmable Multi-Axis 
Controller Model CK3E- Ver.2.2 

OMRON EtherCAT Coupler Unit Model NX-ECC203 Ver.1.4 
OMRON Safety CPU Unit Model NX-SL3500 Ver.1.0 
OMRON Safety Input Unit Model NX-SID800 Ver.1.0 
OMRON Safety Output Unit Model NX-SOD400 Ver.1.0 

OMRON Ethernet cable (with industrial 
Ethernet connector) 

Model 
XS5W-T421-M-K  

OMRON Sysmac Studio SYSMAC-SE2 Ver.1.15 
- Windows computer -  
DT Power PMAC IDE - Ver.2.2 
Acontis  Acontis EC-Engineer - Ver.2.4.3 

 

 

Precautions for Correct Use 

Prepare the ESI file described in this section in advance. Contact your OMRON 
representative for information on how to procure the ESI file. 

 

 Precautions for Correct Use 

Do not share the connection line of EtherCAT communications with other Ethernet networks. 
Do not use devices for Ethernet such as a switching hub. 
Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or 
higher, and use the shielded connector of Category 5 or higher. 
Connect the cable shield to the connector hood at both ends of the cable. 

 

 Additional Information 
This document describes model CK3E- as an example. The same procedures can 
apply to model NY51-A. 

 
 
  

Model CK3E- 
Model NX-ECC203 
 

Windows computer 
Power PMAC IDE 
Acontis EC-Engineer 
Sysmac Studio 

Model NX-SL3500 
Model NX-SID800 
Model NX-SOD400 

Model NX-ID3417 
Model NX-OD3256 

Ethernet 
communications 

EtherCAT 
communications 
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6. EtherCAT Connection Procedure 
 
This section describes the procedure for connecting the Controller with the Slave via 
EtherCAT. The description assumes that the Controller and the Slave are set to factory 
default. 
 

6.1. Workflow 
Take the following steps to operate the PDO communications via EtherCAT after connecting 
the Controller with the Slave via EtherCAT. 

 
6.2 EtherCAT Coupler Unit Settings  Prepare to set the EtherCAT 

Coupler Unit. 
▼   

 6.2.1 Creation of a New Project    
▼   

 6.2.2 Network Configuration Settings   
▼   

 6.2.3 I/O Map Settings   
▼   

 6.2.4 Safety I/O Function Settings   
▼   

 6.2.5 Creation of Safety Programs   
▼   

 6.2.6 Transfer via Connection to the Communications 
Coupler Unit 

  

▼   
 6.2.7 Output of Couple I/O Allocations   

▽   
6.3 Preparation for the Controller Setup  Prepare the Controller settings. 

▼   
 6.3.1 Creation of a New Project   

▼   
 6.3.2 Initial Settings of the Controller   

▽   
6.4 Installation of ESI Files  Install the ESI file for the Slave into 

Acontis EC-Engineer. ▽  
6.5 EtherCAT Communications Setup  Set up EtherCAT communications. 

▼   
 6.5.1 Communications Setup for the EtherCAT Master   

▼   
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 6.5.2 Distributed Clock Setup   
▼   

 6.5.3 Safety Controller Variable Settings   
▼   

 6.5.4 PDO Map Settings   
▼   

 6.5.5 Coupler I/O and Variable Allocations   
▼   

 6.5.6 Creation of an EtherCAT Network Configuration 
File 

  

▽   
6.6 Controller Settings  Set up the Controller. 

▼   
 6.6.1 EtherCAT Network Configuration Settings   

▼   
 6.6.2 EtherCAT Communications Check   

▼   
 6.6.3 EtherCAT Variables Settings   

▼   
 6.6.4 Writing the User Program   

▼   
 6.6.5 Project Data Transfer   
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6.2. EtherCAT Coupler Unit Settings 
Configure the slave terminal settings for the EtherCAT Coupler Unit. 
Prepare a computer with Sysmac Studio installed. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Creation of a New Project 
 

1 Connect the coupler to the 
computer using a USB cable. 

 

2 Turn on the power to the 
coupler and safety controller. 

 

3 Start the Sysmac Studio. 
 
* If the dialog for confirming 
access rights appears upon 
start-up, select starting of 
Sysmac Studio. 

 

4 Create a project in the Sysmac 
Studio. 
 
Project Properties 
Enter Project name and other 
items of information. 
 
Select Device 
Select controller for Category. 
You can specify any Device 
and Version. In this example, 
select NJ501-1500 and 1.10. 
 
Click Create. 

 

  

Windows computer 
Sysmac Studio Model NX-ECC203 

 

USB Cable 

Model NX-SL3500 
Model NX-SID800 
Model NX-SOD400 

Model NX-ID3417 
Model NX-OD3256 
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 Network Configuration Settings 
 

1 Double-click EtherCAT under 
Configurations and Setup in 
the Multiview Explorer. 
 

 

2 Select EtherCAT Coupler Unit 
NX-ECC203 in the toolbox, and 
drag and drop it directly below 
the master in the EtherCAT 
Configuration Edit tab page. 

 

3 Right-click NX-ECC203 in the 
Multiview Explorer, and select 
Coupler Connection (USB) 
then Online. 
 
 
 
 
 
 
 
 
After you have confirmed the 
destination of the USB 
connection, click the OK button. 
 

 

 

4 Double-click NX-ECC203 in the 
Multiview Explorer to open the 
NX-ECC203 edit page. 
 
Right-click in the NX-ECC203 
tab page and select Compare 
and Merge with Actual Unit 
Configuration from the menu. 
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5 Click Apply Actual Unit 
Configuration to apply the 
actual unit configuration. 
 

 

 
 

 Precautions for Correct Use 

You can read only the Unit configuration in the Slave Terminal by comparing and merging 
with the actual Unit configuration. You cannot read the I/O allocation information, Unit 
operation settings, and Unit application data. 

 
 

 I/O Map Settings 
 

1 Right-click NX-ECC203 in the 
Multiview Explorer, and select 
Coupler Connection (USB) 
then Offline. 
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2 In the Multiview Explorer, select 
Configurations and Setup, 
then I/O map tab page to open 
the I/O map pane. 
 
Right-click on NX-ECC203, and 
select Create Device Variable 
from the menu. 

 

3 From the controller selection box 
in the Multiview Explorer, select 
the target Safety CPU Unit. 
 
Double-click I/O map to open 
the Safety I/O map tab page. 
 

 

4 Right-click on EtherCAT 
Network, and select Create 
Device Variable from the menu. 
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 Safety I/O Function Settings 
 

1 From the controller selection box 
in the Multiview Explorer, select 
the target Safety CPU Unit. 
 
Double-click Safety Slave Unit 
Parameter Settings under 
NX-SID800 of Configurations 
and Setup. 

 

2 Select Output Single-channel 
Semi-conductor from the toolbox 
Input device: Semi-conductor 
output type, and drag and drop it 
on to the input terminal.  

 

3 Double-click Safety Slave Unit 
Parameter Settings under 
NX-SO400 of Configurations 
and Setup. 

 

4 
 

Select Single Channel (without 
test pulse) from the toolbox 
Output device, and drag and 
drop it on to the output terminal. 
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 Creation of Safety Programs 
 

1 Registering programs 
 
Right-click Programs under 
Programming – POUs in the 
Multiview Explorer, and select 
Add – Programs from the 
menu.  

2 Creating programs 
 
Refer to Section 7 Programming 
in the Safety Control Unit User’s 
Manual to create safety 
programs. 
 

 

 
 

 Transfer via Connection to the Communications Coupler Unit 
 

1 From the controller selection box 
in the Multiview Explorer, select 
a Safety CPU Unit. 

 

2 Select Controller, then 
Communications Setup from 
the menu. 
 
Select Connect via Coupler in 
the Communications Setup 
dialog box, then click the OK 
button. 
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3 Select Controller, then Online 
from the menu. 
 
The unit is in online connection 
with slave terminals. 

 

4 From the controller selection box 
in the Multiview Explorer, select 
a controller. 

 

5 In the edit page for slave 
terminals, right-click the 
Communications Coupler Unit, 
then select Transfer the 
Settings from computer to 
Communications Coupler. 
 
 
 
 
 
 
 
Click Configuration 
information + Unit operation 
setting + Unit application data. 
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 Output of Couple I/O Allocations 
 

1 Select Controller, then Offline 
from the menu. 

 

2 Double-click EtherCAT under 
Configurations and Setup in 
the Multiview Explorer. 
 
Right-click on Master, then 
select Export All Coupler’s I/O 
Allocations. 

 

 
  



 

20 

6.3. Preparation for the Controller Setup 
Prepare the Controller settings. 
Install Power PMAC IDE and Acontis EC-Engineer on the computer in advance. 
 

 Creation of a New Project 
 

1 Connect the Controller with the 
computer via Ethernet cable. 

 

2 Turn on the power to the 
Controller. 

 

3 Start Power PMAC IDE. 
 
* If the dialog for confirming 
access rights appears upon 
start-up, select starting of  
Power PMAC IDE. 

 

4 The Communication screen 
appears. Specify the IP address 
of the destination Controller and 
click Connect. 
 
* The IP address of the 
Controller is set to 
“192.168.0.200” by default. 
* If necessary, change the 
Windows IP address to 
“192.168.0.X”. 
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5 Power PMAC IDE starts, and is 
online to the Controller.  

 

 

6 From the File menu, select New 
then Project. 

 

 
 

7 Enter a project name and 
location, and select OK. 
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 Initial Settings of the Controller 
Configure the initial settings for the Controller. 
 

 Precautions for Correct Use 

Configuring the initial settings clears all data in the Controller memory. Back up necessary 
data in advance. 

 

1 In the Terminal pane, type the 
$$$*** command to reset the 
Controller to factory default. 

 

2 From the Tools menu, select 
System Setup to start System 
Setup. 
 
 
 
 
 
 
PowerPMAC System Setup starts. 
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3 From the File menu of 
PowerPMAC System Setup, select 
New then Setup. 

 

4 Specify Servo Frequency. 
 
Select the Servo Frequency 
setting from 4 kHz, 2 kHz, or  
1 kHz. 
 
* Servo Frequency is set to 1 kHz 
for the example in this document.  

5 Click the Accept button. 

 

6 If you have changed the servo 
frequency setting, type the SAVE 
command in the Terminal pane of 
Power PMAC IDE. 
When complete, the “Save 
Complete” message appears in 
the Terminal pane. 
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7 Click Communication Setup on 
the toolbar to display the Device 
Properties dialog box. 

 

8 In the Device Properties dialog 
box, select No Device for IP 
Address, then click the Apply 
button. 
 
This operation sets the Controller 
to the offline state. 

 

9 The Controller restarts. 
 
The servo frequency that has been 
set is reflected. 

 

10 Wait until the startup process of 
the Controller is complete. Then 
click Communication Setup on 
the toolbar to display the Device 
Properties dialog box. 
In the Device Properties dialog 
box, return the IP Address to the 
previous setting, then click the 
Apply button. 
 
This operation sets the Controller 
to the online state. 
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6.4. Installation of ESI Files 
Install the ESI file for the Slave into Acontis EC-Engineer. 

 

 

Precautions for Correct Use 

Prepare the ESI file described in this section in advance. Contact your OMRON 
representative for information on how to procure the ESI file. 

 

1 Start EC-Engineer. 

 
 
EC-Engineer screen: 
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2 From the File menu of 
EC-Engineer, select ESI 
Manager. 
 
The ESI Manager appears. 

 
Example of the ESI Manager  

 

3 Confirm that Omron 
NX_Coupler.xml is registered in 
the ESI file list of ESI Manager. 
 
If it is not yet registered, click Add 
File and register Omron 
NX_Coupler.xml. 

 
 
 

4 Click Close to close the ESI 
Manager. 
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6.5. EtherCAT Communications Setup 
Set up EtherCAT communications. 
 

 

Precautions for Correct Use 

Before taking the following steps, make sure that the devices are connected via an Ethernet 
cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet 
cable. 

 
 Communications Setup for the EtherCAT Master 

 

1 Connect the Controller with 
slave devices using an Ethernet 
cable. 
 
* Refer to the manuals for slave 
devices to configure them. 
 

 

2 Display Start Page of 
EC-Engineer, and select 
EtherCAT Master Unit (Class 
A) from Add Master Unit. 

 
 

3 Class-A Master is added to the 
Project Explorer. 
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4 In the Master page, specify a 
communication period for Cycle 
Time [us]. 
 
* You must specify the 
communication period in 
accordance with the servo 
frequency of the Controller. 
1000 us is set in this document. 

 
Correspondence between the servo frequencies of the 
Controller and communication periods is as follows: 
4 kHz : 250 us 
2 kHz : 500 us 
1 kHz : 1000 us  
 

5 In the Master page, set the IP 
address of the destination 
Controller in IP Address, and 
click the Select button to apply 
the setting. 
 
* Default IP address 
“192.168.0.200” is specified in 
this example. 
* Do not select Slaves 
connected to local system as 
it is not used. 

 
 

6 Right-click on Class-A Master 
in the Project Explorer, and 
select Scan EtherCAT 
Network from the menu. 
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7 Make sure that the slave is 
displayed in the Project 
Explorer. 

 

 
 

 Distributed Clock Setup 
 

1 Setting Distributed Clocks (DC) 
for Master 
 
In the Project Explorer, select 
Class-A Master to display the 
Distributed Clocks tab page. 

 
* If the Distributed Clocks tab does not appear, select View 
then the Expert Mode check box. 

 

2 Select Master Shift (EtherCAT 
Master Time controlled by 
Reference Clock). 
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 When using in DC mode 

3 Setting Distributed Clock (DC) 
for the Slave 
 
In the Project Explorer, select 
the target slave to display the 
Distributed Clock tab page. 

 
 

4 Select the Overwrite Mode 
check box and specify Shift 
Time. 

 
Correspondence between the servo frequencies of the 
Controller and Shift Time values is as follows: 
4 kHz : 125 us 
2 kHz : 250 us 
1 kHz : 500 us 
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 When using in Free-Run mode 

3 Setting Distributed Clock (DC) 
for the Slave 
 
In the Project Explorer, select 
the target slave to display the 
Distributed Clock tab page. 

 
 

4 Select FreeRun from the drop 
down list for Operation Mode. 

 

5 In the Advanced Options tab 
page, clear the Potential 
Reference Clock check box. 
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 Safety Controller Variable Settings 
 
(1) Checking the coupler I/O allocations 
Decompress the ZIP file you saved in 6.2.7 Output of Couple I/O Allocations, open the expanded 
“CouplerMemoryMap.xml” using Internet Explorer, and check the contents. 
 
The following is an example displayed using Internet Explorer. 

 
  

Deviece PDO Mapping PDO entry 
Name Name Index Offset Size Name Index Data type Offset Size 
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(2) Setting Input Data 
Register the following input data. 
- Slot1(NX-SL3500)Input Data Set1 
- Slot1(NX-SL3500)Input Data Set2 

 

 

1 Select a safety controller in the 
Project Explorer pane of 
EC-Engineer. 
 
Display the Variables tab page. 

 

2 [Slot1(NX-SL3500)Input Data 
Set1] 
Registering Node1/Unit2 
(NX-SID800) 
 
Click New in the Variables tab 
page, and register two variables 
shown on the right. 
 

 
 

 
Group: Module 1(NX-SL3500).Input Data Set 1 
Datatype: USINT 
Count: 1 
 

 
Group: Module 1(NX-SL3500).Input Data Set 1 
Datatype: UINT 
Count: 3 
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3 [Slot1(NX-SL3500)Input Data 
Set1] 
Registering Node1/Unit3 
(NX-SOID400) 
 
Click New in the Variables tab 
page, and register two variables 
shown on the right. 
 

 
Group: Module 1(NX-SL3500).Input Data Set 1 
Datatype: USINT 
Count: 2 
 

 
Group: Module 1(NX-SL3500).Input Data Set 1 
Datatype: UINT 
Count: 2 
 

4 [Slot1(NX-SL3500)Input Data 
Set1] 
Registering Padding 
 
Click New in the Variables tab 
page, and register the variable 
shown on the right. 
 

Group: Module 1(NX-SL3500).Input Data Set 1 
Datatype: USINT 
Count: 1 
 

5 [Slot1(NX-SL3500)Input Data 
Set2] 
Registering Safety CPU Status 
 
Click New in the Variables tab 
page, and register the variable 
shown on the right. 
 

 
Group: Module 1(NX-SL3500).Input Data Set 2 
Datatype: UINT 
Count: 1 
 

6 Checking Input Data 
 
Make sure that the settings 
(Input) in the Variables tab page 
are correct. 
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(3) Setting Output Data 
Register the following output data. 
- Slot1(NX-SL3500)Output Data Set1 
- Slot1(NX-SL3500)Output Data Set2 
 

 
 

7 Select a safety controller in the 
Project Explorer pane of 
EC-Engineer. 
 
Display the Variables tab page. 

 

8 [Slot1(NX-SL3500)Output Data 
Set1] 
Registering Node1/Unit2 
(NX-SID800) 
 
Click New in the Variables tab 
page, and register two variables 
shown on the right. 
 

 
Group: Module 1(NX-SL3500).Output Data Set 1 
Datatype: USINT 
Count: 1 
 

 
Group: Module 1(NX-SL3500).Output Data Set 1 
Datatype: UINT 
Count: 3 
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9 [Slot1(NX-SL3500)Output Data 
Set1] 
Registering Node1/Unit3 
(NX-SOID400) 
 
Click New in the Variables tab 
page, and register two variables 
shown on the right. 
 

 
Group: Module 1(NX-SL3500).Output Data Set 1 
Datatype: USINT 
Count: 2 
 

 
Group: Module 1(NX-SL3500).Output Data Set 1 
Datatype: UINT 
Count: 2 
 

10 [Slot1(NX-SL3500)Output Data 
Set1] 
Registering Padding 
 
Click New in the Variables tab 
page, and register the variable 
shown on the right. 
 

Group: Module 1(NX-SL3500).Output Data Set 1 
Datatype: USINT 
Count: 1 
 

11 [Slot1(NX-SL3500)Output Data 
Set2] 
 
* Output Data Set2 is not used 
and does not need to be set. 

 

12 Checking Output Data 
 
Make sure that the settings 
(Output) in the Variables tab 
page are correct. 
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 PDO Map Settings 
 

1 In the Project Explorer, select 
the target slave to display the 
PDO Mapping tab page. 
 

  

2 Setting PDO mapping (Inputs) 
 
Confirm the check boxes in the 
Inputs field. 
 
* If you do not want to use data 
in the Inputs field, clear the 
currently displayed check 
boxes. 

 
 

3 Setting PDO mapping (Outputs) 
 
Confirm the check boxes in the 
Outputs field. 
 
* If you do not want to use data 
in the Outputs field, clear the 
currently displayed check 
boxes. 
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 Coupler I/O and Variable Allocations 
 
(1) Checking the coupler I/O allocations 
Decompress the ZIP file you saved in 6.2.7 Output of Couple I/O Allocations, open the expanded 
“CouplerCopyInfo.xml” using Internet Explorer, and check the contents. 
 
The following is an example displayed using Internet Explorer. 

 
 
 
(2) Setting Input Data 
Associate the following items: 
- Module 1 (NX-SL3500).Input Data Set 1, and Module 2 (NX-SID800).Output Data Set 1 
- Module 1 (NX-SL3500).Input Data Set 1, and Module 3 (NX-SOD400).Output Data Set 1 
 
Copy bit size (56 bits) from the source bit offset (160 bits) to the destination bit offset (128 bits). 

 
 

1 Select Class-A Master in the 
Project Explorer page of 
EC-Engineer. 
 
Display the Slave to Slave tab 
page. 

 
  

Original slave model Original SM Original bit offset Destination bit offset 

Original slave model Original SM Original bit offset Destination bit offset 
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2 Associate the variables of 
Inputs Module 1 
(NX-SL3500).Input Data Set 1 
with Outputs Module 2 
(NX-SID800).Output Data Set 
1. 
 
Select an (NX-SL3500).Input 
Data Set 1 item, then select 
the corresponding 
(NX-SID800).Output Data Set 
1 item and click >>. 
 

 
Associate the following items: 

Inputs Outputs 
Variable 0 FSoE Master CMD 
Variable 1 Safety Output 1st Word 
Variable 2 FSoE Master CRC_0 
Variable 3 FSoE Master Conn_ID 

 
 

3 Associate the variables of 
Inputs Module 1 
(NX-SL3500).Input Data Set 1 
with Outputs Module 3 
(NX-SOD400).Output Data 
Set 1. 
 
Select an (NX-SL3500).Input 
Data Set 1 item, then select 
the corresponding 
(NX-SOD400).Output Data 
Set 1 item and click >>. 
 

 
Associate the following items: 

Inputs Outputs 
Variable 4 FSoE Master CMD 
Variable 5 Safety Output 1st Word 
Variable 6 FSoE Master CRC_0 
Variable 7 FSoE Master Conn_ID 

* Variable 8 does not need to be allocated. 
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(3) Setting Output Data 
Associate the following items: 
- Module 2 (NX-SID800).Input Data Set 1, and Module 1 (NX-SL3500).Output Data Set 1 
- Module 3 (NX-SOD400).Input Data Set 1, and Module 1 (NX-SL3500).Output Data Set 1 
 

4 Associate the variables of Inputs 
Module 2 (NX-SID800).Input 
Data Set 1 with Outputs Module 
1 (NX-SL3500).Output Data 
Set 1. 
 
Select an (NX-SID800).Input 
Data Set 1 item, then select the 
corresponding 
(NX-SL3500).Output Data Set 
1 item and click >>. 
 

 
Associate the following items: 

Inputs Outputs 
FSoE Master CMD Variable 0 
Safety Output 1st Word Variable 1 
FSoE Master CRC_0 Variable 2 
FSoE Master Conn_ID Variable 3 

 

5 Associate the variables of Inputs 
Module 3 (NX-SOD400).Input 
Data Set 1 with Outputs Module 
1 (NX-SL3500).Output Data 
Set 1. 
 
Select an (NX-SOD400).Input 
Data Set 1 item, then select the 
corresponding 
(NX-SL3500).Output Data Set 
1 item and click >>. 
 

 
Associate the following items: 

Inputs Outputs 
FSoE Master CMD Variable 4 
Safety Output 1st Word Variable 5 
FSoE Master CRC_0 Variable 6 
FSoE Master Conn_ID Variable 7 

* Variable 8 does not need to be allocated. 
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 Creation of an EtherCAT Network Configuration File 
 

1 Click Export ENI on the upper 
part of the EC-Engineer page. 

 

2 Enter a file name, and then click 
Save to create an EtherCAT 
network configuration file. 
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6.6. Controller Settings 
 

 EtherCAT Network Configuration Settings 
 

1 From the Tools menu of Power 
PMAC IDE, select System Setup 
to display System Setup. 
 

 

2 Click Browse, and load the 
EtherCAT network configuration 
file created in 6.5.6 Creation of an 
EtherCAT Network Configuration 
File.  

3 Click Download ENI file to 
download the EtherCAT network 
configuration to the Controller. 

 
 
 
 EtherCAT Communications Check 
 

Take the following steps to ensure that EtherCAT communications are available. 

1 From the Terminal pane, run the 
ECAT[0].Enable=1 command to 
start EtherCAT communications. 
 
 

 

2 In the Terminal or Watch pane, 
make sure that the 
ECAT[0].Enable value turns to 1. 
 
* The OP mode is entered and 
EtherCAT communications are 
established. 
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3 After making sure that correct 
communications are available, run 
the ECAT[0].Enable=0 command 
from the Terminal pane to stop 
EtherCAT communications. 
 

 

4 In the Terminal or Watch pane, 
make sure that the 
ECAT[0].Enable value turns to 0. 
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 EtherCAT Variables Settings 
 

1 In the System Setup page, 
right-click on 
Master[0].Deactivated to 
display the pop-up menu, and 
select Export EtherCAT 
Variables. 
 
 

 

2 Enter a name for the EtherCAT 
variable definition file for user 
programs into the root of the 
project folder. 

 

3 The created EtherCAT variable 
definition file is added to under 
Global Includes of PMAC 
Script Language in Solution 
Explorer. 
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 Writing the User Program 
Create programs to be used to check operations. 
A specific language is used for the operation check programs. Refer to Power PMAC User’s 
Manual and Power PMAC Software Reference Manual for details. 
 

1 In the Solution Explorer pane, 
open Project name – PMAC 
Script Language – PLC 
Programs – plc1.plc. 

 

2 In the programming area of the 
plc1.plc tab page, write a 
program as show on the right. 
 
This sample program blinks the 
NX-OD3256 output indicator 
every second. 
 
* In this example, PDO 
mapping is assumed to be the 
default setting. If you want to 
change PDO mapping, rewrite 
the “Slave_0....” description. 

 

open plc 1 
 

while(sys.ecatMasterReady==0){}; 
 
ECAT[0].Enable = 1; 
 
P1000=Sys.Time+1; 
while(P1000>Sys.Time){}; 
 
Slave_0_7080_2_OutputBit01 = 1; 
 
P1000=Sys.Time+1; 
while(P1000>Sys.Time){}; 
 
Slave_0_7080_2_OutputBit01 = 0; 

 
close 
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3 Setting the start of the user 
program 
 
In the Solution Explorer pane, 
open Project name – 
Configuration – 
pp_disable.txt. 
 
 
 

 

4 In the programming area of the 
pp_disable.txt tab page, add 
the program shown on the right 
to the last line. 
 
The pp_disable.txt program is 
automatically executed when 
the Controller starts. 
This example program runs the 
PLC1 script. 

 

 
 

 Project Data Transfer 
Transfer the created project data to the Controller. 
 

 
When the user program and “configuration and setting” data are transferred from 
Power PMAC IDE, devices or the machine may perform unexpected operations. 
Therefore, before you transfer project data, ensure the destination slave is 
operating safely.  

 

 
Transferring project data restarts the Controller and interrupts communications 
with slaves. The time that communications are interrupted depends on the 
EtherCAT network configuration. 
Before you transfer project data, make sure that the slave settings will not 
adversely affect the devices. 

 

 
enable plc 1; 
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1 In the Terminal or Watch pane, 
make sure that the 
ECAT[0].Enable value is 0. 
 
If the value is 1, run the 
ECAT[0].Enable=0 command 
from the Terminal pane to stop 
EtherCAT communications. 

 

2 Downloading a project 
 
Right-click the project name in 
the Solution Explorer pane on 
the upper right of the IDE 
screen, and select Build and 
Download All Programs to run 
the build and download. 

  

3 Make sure that there are no 
errors in the Output tab page. 
 
* If the transfer fails, check 
details of the error in the Output 
tab page. 
If the error is a program error, 
you must review the program. 
If the error is related to 
EtherCAT settings, return to 
System Setup and check 
whether there are any incorrect 
settings. 
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4 The program starts running 
when it has been downloaded 
successfully. 
 
EtherCAT communications are 
in the OP state. Make sure that 
the NX-OD3256 output indicator 
blinks. 
 
* If the indicator does not blink, 
check that the ECAT[0].Enable 
value is 1 in the Terminal or 
Watch pane. 
If the value is 0, run the following 
command from the Terminal 
pane. 
enable plc 1 

 

 

5 After you have confirmed an 
appropriate operation, save the 
project to the Controller. 
 
Run the save command from the 
Terminal pane. 
 
* The transferred project is not 
yet saved to the Controller at 
this stage. 
If you turn OFF the power to the 
Controller, the transferred 
project will be discarded. 
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7. Appendix Saving and Loading a Project 
 
The following describes the procedures to save a Power PMAC IDE project on the computer, and to 
reuse it. 
 

7.1. Saving a Project 
 

1 Creating a Configuration File 
 
Create a Configuration File to 
save parameters you have 
changed in System Setup to the 
project. 
 
Right-click Configuration in the 
Solution Explorer pane, and 
select Generate Configuration 
File. 
A Configuration File is added to 
Configuration. 
 

 

2 Right-click on the Configuration 
File, and from the menu, select 
Check To Download Config File 
to include it in files to be 
downloaded. 

 

3 Saving a Project 
 
In the File menu, run Save All to 
save the project on the computer. 
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7.2. Loading and Downloading a Project 
 

1 Start Power PMAC IDE, and 
connect to the Controller. 

 

2 In the Terminal pane, type the 
$$$*** command to reset the 
Controller settings to factory 
default. 

 

3 In the File menu, Click Open – 
Project/Solution to load the 
project that you saved. 

 

4 From the Tools menu of Power 
PMAC IDE, select System Setup 
to display System Setup. 

 

5 Click Browse, and load the ENI 
file that you created in 6.5.6 
Creation of an EtherCAT Network 
Configuration File. 
 

 

6 Click Download ENI file to 
download the EtherCAT network 
configuration to the Controller. 
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7 Right-click Configuration in the 
Solution Explorer pane, and 
select Download Config Files to 
download the file to the Controller. 
 

 

8 Right-click the project name in the 
Solution Explorer pane, and 
select Build and Download All 
Programs to run the build and 
download. 
 
When the download process is 
complete, make sure that there 
are no errors in the Output tab 
page. 

 

9 Stopping a program 
 
If a program is running, execute 
the following command from the 
Terminal pane to stop the 
program. 
disable plc 1 
ECAT[0].Enable=0 
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10 Saving the downloaded settings 
and programs 
 
After the download process is 
complete and you make sure that 
there are no errors in the Output 
tab page, run the save command 
from the Terminal pane. 
 
* The save command stores the 
downloaded project in the 
Controller. This operation saves 
the settings to be executed 
automatically when the power to 
the Controller is turned on. 

 

11 Restarting after download 
 
Run the following command from 
the Terminal pane to restart the 
Controller with the downloaded 
project. 
$$$ 
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8. Appendix Troubleshooting 
 

8.1. Factors Causing EtherCAT Communications To Be Unavailable, and 
Corrective Actions 

 
Description Factor Corrective Action 
The link is not established. The Ethernet cable is broken or 

the specified cable is not being 
used. 

If the Ethernet cable is broken 
or if the specified cable was not 
used, replace the cable. 

A connector on the Ethernet 
cable used for EtherCAT 
communications is 
disconnected, the contact is 
faulty, or parts are faulty. 

Reconnect the connector and 
make sure it is mated correctly. 

A slave within the EtherCAT 
network configuration failed. 

Replace the slave. 

EtherCAT communications do 
not start. 

ECAT[0].Enable is set to 0. From the Terminal pane, run the 
ECAT[0].Enable=1 command to 
start EtherCAT communications. 

The EtherCAT network 
configuration in the Controller 
does not agree with the 
physical network configuration. 

Review the settings according 
to the procedures provided in 
6.5 EtherCAT Communications 
Setup. 

The Ethernet cable is broken at 
a slave in the network, or a 
connector is disconnected. 

Connect the Ethernet cable 
correctly. 

Some errors have occurred, 
and the ECAT[0].error is set to a 
value other than 0. 

Check the ECAT[0].error value. 

A synchronization error occurs 
at a slave. 

The distribution clock is not set 
correctly. 

Review the settings according 
to the procedures provided in 
6.5.2 Distributed Clock Setup. A slave in Free-Run Mode is set 

to the reference clock. 
The servo task processing time 
exceeds the set period. 

Review the program or servo 
frequency to adjust it, so that 
the servo task processing time 
does not exceed the period. 
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8.2. How to Check for Errors 
 

 Checking the EtherCAT Status 
You can check the EtherCAT status from System Setup of Power PMAC IDE and Diagnosis Mode 
of Acontis EC-Engineer. 
 
 System Setup of Power PMAC IDE 
You can check the status of the EtherCAT master and slaves in the System Setup page of Power 
PMAC IDE. 

 
 
 
 Diagnosis Mode of Acontis EC-Engineer 
You can check the status of the slaves in the Diagnosis Mode page of Acontis EC-Engineer. 
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Select Network then Network Mismatch Analyzer from the menu to verify the network configuration. 

 

 
 

 Checking the Controller Status 
In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system, 
and system. 
To display the Status page, click Status on the toolbar. 
 
 
 Global Status 
You can check system errors such as the WDT error. 
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 Motor Status 
You can check deviation errors, limit errors, and other states of the motor. 

 
 
 Coordinate Status 
You can check deviation errors, limit errors and other states of the coordinate system. 
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9. Appendix ECAT[i] Structure Elements 
 
The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc., 
(hereafter referred to as DT) in the U.S., however, the ECAT[i] structure elements differ from those of 
DT controllers. The following table shows the major changes that have been made from DT 
controllers. 
 
Element name Description Change 
ECAT[i].Enable Enabling the EtherCAT 

network 
0: Disable, 1: Enable 
(2 and 3 are not supported.) 

ECAT[i].LPIO[k] Elements of low priority 
I/O module 

Not supported 

ECAT[i].Slave[j] Slave elements Not supported 
ECAT[i].Error Error code of enabling 

EtherCAT network 
$ 9811000C: Invalid network 
configuration 
$ 9811002E: Disconnected network 
connection 

ECAT[i].LinkUp 
ECAT[i].LPDomainOutputState 
ECAT[i].LPDomainState 
ECAT[i].LPRxTime 
ECAT[i].LPTxTime 
ECAT[i].MasterStat 
ECAT[i].RTDomainOutputState 
ECAT[i].RTDomainState 

Status data structure 
elements 

Not supported 

 

  



 

58 

10. Revision History 
 

Revision 
code 

Revised date Revised content 

01 July 1, 2016 First edition 
02 April 10, 2023 Corrected mistakes. 
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